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[bookmark: List_of_Tables]Use this table of contents (TOC) as an example of what one looks like. When it comes time for creating your own TOC, RIGHT CLICK anywhere in the Table of Contents, select UPDATE FIELD, then select UPDATE ENTIRE TABLE or UPDATE PAGE NUMBERS ONLY, and click OK. 
The table of contents will be generated using the style tags from the template; you will also be able to automatically update the TOC, both added headings and page numbers.
[bookmark: _Toc259446893]
List of Tables
Table 1. A Sample Table Title Showing Correct Formatting	5
When you update the list of tables, the table number and title will come in without a period between them; you will need to manually add that period after all table numbers, as shown for Table 1. In addition, the title will retain the italics from the narrative when the List of Tables is updated. Once your list is finalized, select the entire list and change it all plain type.

[bookmark: _Toc259446894]
List of Figures
Figure 1. Figure caption goes here	xx
The List of Figures is not set up to automatically update. If you have figures in your document, type them in manually here, following the example above.
Alternately, follow these instructions, which will allow automatic updating of the List of Figures.
1. Use the cursor to highlight the figure number and caption where they appear in the narrative chapters. (Figure 1. Figure caption.)
1. Press Shift + Alt + the letter o). In the Mark Table of Contents Entry that comes up, you will see the figure information that you highlighted in the Entry box. Put A in the Table Identifier box. Put 1 in the Level box. Do not close the Mark Table of Contents Entry box. Work can be done while it is open.
1. Continue to follow this protocol for all figures. You will see parenthetical entry field coding beside each figure caption when you have the formatting showing.
1. Close Mark Table of Contents Entry box.
1. Place your cursor on the List of Figures page in the TOC.
1. Open the References tab.
1. Left click Insert Tables of Figures.
1. In the Table of Figures box that comes up, put a check in the “Show page numbers” and “Right align page numbers boxes.” Remove the check from the hyperlink box. Put dot leaders in the Tab leader box. Under General, format is “from template.” Caption label is “Figure.” Put a check in the “Include label and number” box.
1. Go to Options. Remove check from “style” box. Put a check in the “Table entry fields” box. Put A in the Table identifier box. Click OK. Click OK again on initial Table of Figures box.
1. The figures will appear on the List of Figures page. You may have to reformat the spacing and font. If the captions themselves change in the narrative, this whole process must be repeated. If only the page numbers change, do this:
1. Left click to place the cursor anywhere on the figures mentioned on the List of Figures page.
1.  Right click “Update field.”
1. Place bullet in circle for option to update page numbers only.
1. Left click OK.
1. The page numbers will update automatically.


Abstract
Insert abstract here; it should be no more than 250 words. Abstract text must be double-spaced with no paragraph breaks. Describe the overall research problem being addressed in the first couple of sentences and indicate why it is important (e.g., who would care if the problem is solved). You can include a general introduction of the issue in the first sentence, but you need to move to a clear statement of the research problem being addressed. Identify the purpose and theoretical foundations, if appropriate, summarize the key research question(s), and briefly describe the overall research design, methods and data analytic procedures. Identify the key results, one or two conclusions, and recommendations that capture the heart of the research. Conclude with a statement on the implications for positive social change. Here are some form and style tips: (a) limit the abstract to one typed page; (b) maintain the scholarly language used throughout the dissertation; (c) keep the abstract concise, accurate, and readable; (d) use correct English; (e) ensure each sentence adds value to the reader’s understanding of the research; and (f) use the full name of any acronym and include the acronym in parentheses. Do not include references or citations in the abstract. Per APA 7th style, unless at the start of a sentence, use numerals in the abstract, not written out numbers. 
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[bookmark: Chapter_1][bookmark: _Toc259446895]Chapter 1: Introduction to the Study (Level 1 Heading)
Opening paragraph starts here
Level 2 Heading
Place your text here.
[bookmark: _Toc259446897]Level 3 Heading
Place your text here; when placing your cursor on this text, you will see in the ‘styles’ menu that this paragraph is tagged “Body Text.” That means it will automatically appear double-spaced with the first line indented, per SHSS style. The seventh (7th) edition of the APA manual advises one-character spaces between sentences. Either one or two spaces; is acceptable, just be consistent. The text in this template has one-character space between sentences.
You can find the style menu in Word 2007 by clicking on the Home tab on the standard toolbar; Styles is one of the choices you will see. Click on the arrow icon on the right side of the Styles bar, and the drop-down menu of styles will appear. In Word 2003, look in the upper left corner of your screen, on the formatting toolbar, for the drop-down style menu. 
To apply this template’s formatting to the text of your paper, simply highlight the paragraph(s) or heading you want to format and choose the appropriate tag from the style menu. The list of style tags includes all levels of headings, block quotes, table and figure captions, references, and body text. 
Level 4 heading. Text begins here. (these two Headings will not appear in the Table of Contents).
Level 5 heading. Text begins here. The following is an example of a block quote:
This is an example of a block quote (a quote that is four or more lines or 40 or more words). Now is the time to do the work that needs to be done. This is an example of a block quote. Now is the time to do the work that needs to be done. This is an example of a block quote. Now is the time to do the work that needs to be done. This is an example of a block quote. Now is the time to do the work that needs to be done. (Author, date, p. #)
If you make a mistake and something changes that you did not want to change, in MS Word, either type Ctrl (Control key) z or, on the Quick Access toolbar, next to Save, click on the arrow icon for Undo. In Word 2003, go to Edit, Undo Typing. 
As you continue to develop your proposal and dissertation in this template, use the instructions in Comments 9 to12 to add new headings and new text. 
[bookmark: Chapter_2][bookmark: _Toc259446898]
Chapter 2: Literature Review
[bookmark: _Toc259446899]First Heading
Insert the text of your literature review here. Report the literature in past tense, as in Jones (2003) argued, not Jones (2003) argues. Refer to the rubric for guidance on the content of sections in this chapter.
Here are some additional tips for presenting data in vertical list form.

1. In the body of your paper, use this format when presenting information as a vertical list.
2. When the order of the items in the list is important, use a numbered list. Use a bulleted vertical list when you do not need to indicate a certain order or chronology.
· This is an example of a bulleted list.
· It follows the same format as for a numbered list, with the bullet point indented the same as a paragraph indent.

[bookmark: _Toc259446900]
Chapter 3: Research Method
[bookmark: _Toc259446901]First Heading
Discuss your research method here. Refer to the rubric for guidance on the content of sections in this chapter.

[bookmark: Chapter_4][bookmark: _Toc259446902]
Chapter 4: Results 
[bookmark: _Toc259446903]First Heading
Present your results here. Refer to the rubric for guidance on the content of sections in this chapter.
This is an example of a table in APA 7th style (see Table 1).
[bookmark: _Toc239582816]Table 1
A Sample Table Showing Correct Formatting
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**p < .01.
[bookmark: Figures][bookmark: Chapter_5]Note. From “Attitudes Toward Dissertation Editors,” by W. Student, 2008, Journal of Academic Optimism, 98, p. 11. Reprinted with permission.
**Tables should appear as demonstrated above, they should not be tables with all borders outlined.**

This is an example of a figure labeled per APA 7th style. Note that the label is placed over the figure itself. As with tables, refer to the figure by number in the narrative text preceding the placement of the figure (see Figure 1).
Figure 1
Core elements of conflict analysis

Note. This graphic provides a map for conflict analysis, giving the researcher and/or humanitarian aid worker a means to build a clearer understanding of the conflict and/or issue at hand, this example addresses indigenous and dominant culture interaction, from, https://gsdrc.org/topic-guides/conflict-analysis/core-elements/
Follow these instructions to allow figure number and caption to update in the List of Figures.
1. Use the cursor to highlight the figure number and caption. (Figure 1. Text.)
2. Press Shift + Alt + the letter o). In the Mark Table of Contents Entry that comes up, you will see the figure information that you highlighted in the Entry box. Put A in the Table Identifier box. Put 1 in the Level box. Do not close the Mark Table of Contents Entry box. Work can be done while it is open.
3. Continue to follow this protocol for all figures. You will see parenthetical entry field coding beside each figure caption.
4. Close Mark Table of Contents Entry box.
5. Place your cursor on the List of Figures page in the TOC.
6. Open the References tab.
7. Left click Insert Tables of Figures.
8. In the Table of Figures box that comes up, put a check in the “Show page numbers” and “Right align page numbers boxes.” Remove the check from the hyperlink box. Put dot leaders in the Tab leader box. Under General, format is “from template.” Caption label is “Figure.” Put a check in the “Include label and number” box.
9. Go to Options. Remove check from “style” box. Put a check in the “Table entry fields” box. Put A in the Table identifier box. Click OK. Click OK again on initial Table of Figures box.
10. The figures will appear on the List of Tables page. You may have to reformat the spacing and font. If the captions themselves change, this whole process must be repeated. If only the page numbers change, do this:
a. Left click to place the cursor anywhere on the figures mentioned on the List of Figures page.
b.  Right click “Update field.”
c. Place bullet in circle for option to update page numbers only.
d. Left click OK.
e. The page numbers will update automatically.
[bookmark: _Toc259446904]
Chapter 5: Discussion, Conclusions, and Recommendations
[bookmark: _Toc259446905]First Heading
Insert summary, conclusions, and recommendations here. Refer to the rubric for guidance on the content of sections in this chapter.

[bookmark: References][bookmark: _Toc259446906]
References
Insert References here. Examples of some common types of references follow; see APA 6.22 and Chapter 7 for more details. 
These sample entries are tagged with the “APA Reference” style tag, which means the line spacing and hanging indent are automatic. Apply the “APA Reference” style tag to your entries.
Pay special attention to italics, capitalization, and punctuation. The style tag does not govern those aspects of the entry.
Periodical (journal)
Author, A. A., Author, B. B., & Author, C. C. (1994). Title of article. Title of Periodical, xx(x), xxx-xxx.
Online periodical (journal)
Author, A. A., Author, B. B., & Author, C. C. (1994). Title of article. Title of Periodical, xx(x), xxx-xxx. doi: xxxxxx
Nonperiodical (book)
Author, A. A. (1994). Title of work. Publisher.
Chapter in a book
Author, A. A., & Author, B. B. (1994). Title of chapter. In A. Editor, B. Editor, & C. Editor (Eds.), Title of book (pp. xxx-xxx). Publisher.
The Publication Manual of the American Psychological Association, Sixth Edition, Chapter 7, includes numerous examples of reference list entries. 
[bookmark: _Toc259446907]
Appendix A: Title of Appendix
Insert appendix here. Appendices are ordered with letters rather than numbers.
The appendices must adhere to the same margin specifications as the body of the dissertation. Photocopied or previously printed material may have to be shifted on the page or reduced in size to fit within the area bounded by the margins.
If the only thing in an appendix is a table, the table title serves as the title of the appendix; no label is needed for the table itself. If you have text in addition to a table or tables in an appendix, label the table with the letter of the appendix (e.g., Table A1, Table A2, Table B1, and so on). These tables would be listed in the List of Tables at the end of the Table of Contents. 
If you include in an appendix any pre-published materials that are not in the public domain, you must also include permission to do so.

[bookmark: CV]One optional appendix is a brief bio or CV.

For additional APA 7th guidance on citation and references, please see: 
Changes in the 7th Edition // Purdue Writing Lab
For samples of statistical tables, please see:
https://apastyle.apa.org/style-grammar-guidelines/tables-figures/sample-tables

Congratulations! This is the end of your dissertation! Be sure to delete this text!
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